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Download/Install IMU3

DOWNLOADING IMU3

%+ Pete Andersen, who created IMU, has made positive changes to the
program. Downloading and installing IMU3 is easier than ever.

%+ Open any web browser and go to the URL
http://www.pandersys.com/imu3setup.exe

%+ When the download starts - save the downloading file
“Iimu3setup.exe” to your desktop (or somewhere else you can find it).

=+ That's all it takes to obtain the program. Now to install it.




Download/Install IMU3

INSTALLING IMUS

%+ After download, start the install by double-clicking that install file
“Iimu3setup.exe”.

%+ Follow the instructions for install using the suggested defaults at each
step — its mostly goof-proof! But when it asks for your Wing — enter
TX for Texas.

% Install program will create a START menu category “IMU3” to start the
program; different than older versions that merely put a shortcut to the
program directory.

%+ At the end of the install — the setup program will ask to start IMU3 for
your first use.




Download/Install IMU3

UPDATING IMU3

+ When IMUS starts for the first time — it will notify you there is a newer
version available. Click OK to download and install the update.

% If everything works correctly — you should see the download in a “File
Transfer Progress” box at the top of the screen.

%+ At the end of the download, click the OK box and it will automatically
Install the update.

%+ Now, you're finally ready to start and use IMU.

+ Well... As soon as we get a current database to use!




Open IMUS3 for First-Time Use

= IMU3 has now started for the first time. And what do you see at the
bottom — “Database: Not Found™ Uh Oh!

File Help
IMU Setup

Mode Selector
SETUP

Wing

« Local

© Network Client

" Internet Server Client
 WMU Archive

Start
Application

Setup Validation
WorkStation Name CHUCK-

Core Date Data Interface

Architecture Date Data Interface

Quit ‘

Database: Not Found




Open IMUS3 for First-Time Use

= So now, we’ll talk about how to get that database and use it. And to

accomplish this — there is a new & easy module built right in!

NOTE: You must hold mission staff qualifications to get the IMU
database and use it. MSA is the minimum qualification!

Click the “File” menu at top, select the “FTP Information” submenu,
and in there — select “Set Admin Permission”. This screen looks just
like the older IMU2 login screen — you merely put in your CAP ID and
birthdate to get access to the IMU server’s database.

Now select the “File” menu a second time, the “FTP Information”
submenu, and FTP. When the window pops up, put in
http://pandersys.com for the Host URL, pandersys.com for the FTP
Address. Make sure the “Passive” and “Long” boxes on the right are
clicked.




IMU Setup - 3.1.0.29 Browser: 1.0.0.9
File Help

Host URL ar IP Address:
(Include Http://)

FTP Addiess:
Mo FTF://)

Folder ar Path:

FTP User Hame:
 Default

Fazzword:

Re-enter Password:

Save

Cancel

IMU Setup

Database FTP Information

http:lipandersys.com v P21
pandersys.com Passive
Long
(%) User ) Admin

[ ] @ pandersys.com
[] Include Host Header in User Name

| Save and Use |

Get Database From Host Site |




Open IMUS3 for First-Time Use

= Now click the box labelled “Default”, right under the “FTP User
Name”. It will automatically fill in the FTP username and password.

NOTE: The CAP ID and birthdate you put in earlier is checked so the
program can verify you are authorized access to IMU. You MUST be
gualified at least MSA to get access. Without that qualification — you
will not get the database!

= That completes the database download set up. Now click the “Get
Database From Host Site” which will download the newest Texas
database from the IMU server.

- After its done downloading, click the “Save and Use” button at bottom.
- That's it! Once back on the main IMU program screen - make sure

you select “Internet Server Client”, and then “Start Application”.
IMU3 will now start and allow you to log in.




IMU Setup - 3.1.0.29 Browser: 1.0.0.9
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Login Changes

New way to Log into IMU3

%+ Pete Anderson has changed how we log in to the program.

% To enhance security, and check that the person has the qualifications
to use the more advanced tools in IMU — the program now
authenticates through eServices.

%+ Click the “Login” button. Instead of the old version’s window asking
for your CAP ID and birthdate — it now opens a window and brings up
the eServices login. Log in just as if you were using eServices.

%+ When eServices confirms authentication — IMU3 will allow you in.
%+ If you get a Certificate warning, just click “Continue to this website”.

% You're now logged into IMU3 and can open an Incident (same as the older

version of IMU).




Incident:
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General | Commant
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Your login is being
processed by e-Services.
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Incident D ate: Local: GMT:

Incident Type:

&%ﬁ; Civil Air Patrol eServices Sign In

Welcome to Civil Air Patrol eServices. The site you are accessing requires a username and
password. Please enter them below and click 'Sign In" to proceed. After signing in, you will
be returned to the eServices home page.

CAPID or User Name

Password

Sign In |

i) Need Help Logging On?

First time eServices users click here to activate your account!
Forgot password? Click here for password assistance.

- Looking For Something Else?

General CAP information is available at www . gocivilairpatrol.com
Visit members. gocivilairpatrol. com for detailed member information.




Open Incident

How do | open a mission to use?

%+ After logging into IMU — its ready to open a mission for use.

% Click the top/left box labelled “Click to Open Incident”. A window
appears. Choose the mission you are working in.

%+ When you choose the mission — the window populates all the
iInformation boxes except two:

1) Make sure the “Incident Date” has the correct date (today)
2) Putin the “Local Base Name” (where you are located)

%+ Now click OK at the bottom. You’'re ready to use IMU and
access/modify the data for that particular mission.




™ Incident Management Utilities (IMU) - (Charles Tetlow)
Flle Help

Incident: Incident Date: Local:

T D 1028/10 00:11 | [10/28/10 05:11

Incident Opened by: Incident Type:

Requesting Agency. | USAF
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Incident Close Date: 111.-"02;’10 |[_] Funding § 15000
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icp- |E38 ‘ [] Restrict Access{ocal Base Name:
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Check In/Out Procedures

%+ Now, you’ve done all this work installing and getting IMU ready for
use. But what use? What is IMU used for?

% Our primary use for IMU is mission Check-In / Check-Out.

% Click the “Incident Checkin” button on the front screen — the
Participant Checkin window will open to check in members.

=+ Start at the top left field. You can start entering a member’s last
name — it will guess as soon as you've entered enough of the name
that it can differentiate from other members. Or you can enter the
member’s CAP ID. Hit the “Validate” button, or just press ENTER.

%+ IMU will populate most of the fields in this Participant Checkin
window. Lets talk about the ones that don’t auto-fill.

%+ The first is where the member departed from. This is usually a airport
three/four letter identifier, or “Home”.




Check In/Out Procedures

%+ Next, choose the “Method of Transportation” using the pulldown. If
the member drove a vehicle or was PIC of a plane — when you
choose to check in that vehicle or aircraft — additional information
fields will pop up on the right side. Fill them in to check the vehicle or
aircraft into the mission.

%+ At the bottom right — the area “CAP Checklist” should all be green. If
the “Membership” label is red — the person’s CAP membership has
expired and he/she can't participate. If the “Next of Kin” is red — click
It to enter the member’s next of kin contact information.

<+ Once done — the “Checkin” button at bottom will be solid black
(instead of grey). Click it to check the member into the mission.

=% If that button is grey, you’'ve missed putting some data in somewhere.
Although sometimes you merely have to click into another block (like
Departed From) to turn that button black and then you are able to
check the member in.




Participant Checkin
File Help

Participant ldentification
Select Name or Enter CAPID

Tetlow, Charles M Jr | Validate l

Individual v

Participant Information
Organization | A p CAPID (373537

Last Name 7.0 J First Name |}, .¢1es
M [ J Suffix |, J Grade |,

Wing Exp [Feb 11

Home Base [Tx.

ansportation (Aircraft - Aircraft Checkin

Qualifications GES 1C2 1C3 A
LO MO MP MRO MS MSA MSO

2|

Incident Duty Positions are made using the Planning
Section Resources Unit button.

Assigned to Base

Local Time: [00:14 ‘E33

Duty Day Information

Checkin Time [1{;.,-23;10 00:13 | Duty Day

Rircraft Checkin
TailNumoer N 165CP

TY0E | C182/G1000 |
CABRISNE 4216
HumeBasefSSF

Sests 4

Narting Fust 50|

Membership
CAPF 101 Card
Next of Kin

[ Cancel




Check In/Out Procedures

% Last. After you check everyone into the mission — how do we check
them out when leaving??

% In the Participant Checkin window — choose the File menu at top/left
and select “Checkout”. Anther new window appears!

% In this Checkout window — you can checkmark the box next to each
person, vehicle, or plane that is leaving the mission. When you’'ve got
each check marked — hit the “Checkout” button at bottom right.

+ WARNING! Be EXTREMELY careful about the “Select All” buttons
on the left side. If you hit “Select All” next to the Personnel area, and
check everyone out of the mission — the IC isn’t going to be happy!
The IC or someone on staff will have to go into IMU and re-checkin
everyone still at the mission. That’s not going to make you the IC’s
favorite...




Perzonnel |

Schmidt, Joshua D
[] Tetlow, Charles M Jr

[] Tetlow, Lorrie A

Clear All

Resources: [ 1 N165CP
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Ti j .
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Summary

% If you knew how to use IMU2 — you’ll have no problem with IMU3.
This new IMU3 is almost identical to the previous version 2.

% The primary changes are to the way you log into IMU to use it. This
new version integrated closely with eServices — and uses eService’s
authentication.

% And this new version is much easier to set up the database. The
Integrated FTP module described earlier is a almost hands-off
method.

% But the initial start up screen “File” menu also contains options to
move a newly downloaded database to the correct location for IMU to
use, and a option to copy the current database you're using to the
desktop (to send to someone else).

% But both of those options are primarily for use when running in “Local
Mode”. But this tutorial is primarily written for using ‘virtual mode’ or
as its known now — Internet Server Client mode.




Virtual Mode Consideration

2+ When running IMU3 in this “Virtual Mode” — the server keeps track of
who is logged into the system.

% This could be important to the I.C. and staff if they need to get everyone
off the system for database management (upload or download).

% This means that everyone should have a “computer name” that is
descriptive of who you are. This is set on your own computer — in the
Control Panel, System Properties, and the Computer Name tab.

%+ Please use your last name or whole name as part of your computer’s
name “JoeSmith_laptop”, or “JaneDoe”, or “TxWg_Laptopl”. Something
that could be used to track you down if the IC needs to get everyone off
the system for maintenance.

% And you can see your own computer’s name in the “IMU Database
Connectivity” display under the “Help” menu item.

%+ Please help us operate more efficiently by using a good, descriptive
computer name.




Contact Information

| hope this tutorial on using IMU3’s Virtual Mode is helpful to you
when running your mission.

= Please remember — the focus of this tutorial is using IMU3 in “Virtual
Mode” or as its known now “Internet Server Client mode”. Other
material will be released for ICs covering topics like “IMU3 Local
Mode”, “IMUS3 tools” and “Database Management”.

- If you need more assistance and are in the Texas Wing — feel free to
contact me at any time. | suggest Texas Wing because other Wings
may have different policies and use IMU in different ways.

= One last caveat — | am not a programmer. If you get installation
errors, exceptions, or .NetFramework problems — | can’t help you.
Sorry.... | suggest you review the installation instructions on the
WMU website at https://wmu.nat.cap.gov

= My name is Major Charles Tetlow, e-mail is ‘Chuck@Tetlow.Net’, and
my phone number is 210-967-8712.
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